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Contact information 
 

email: info@cheekyted.co.uk 
 

Twitter: @cheekyted 
 

Web: www.cheekyted.co.uk 
 
 
 
 
 
 

Current version 
The current version of CTFileFilter can be downloaded from our website 

http://www.cheekyted.co.uk and following the download link 
 

Follow us on Twitter to get the newest update information 
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****************************************************************************************** 
CTFileFilter (c) 2010 CheekyTed Software 

****************************************************************************************** 
 
CTFileFilter is supplied as shareware meaning that there are some limitations in its use, but you 
may use it for a limited time on a trial basis. The full functionality of the program is available by 
purchasing a Professional licence.  You will require the PC ID code as shown on the settings tab 
of CTFileFilter, then go to our website and enter this number in the box labelled PC ID before 

clicking on the 'Buy Now' button. 
 

Note: The unlicensed shareware version will require updating regularly. 
 
 

 

Disclaimer of Warranty 
THIS SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE IT AT YOUR OWN RISK. YOU ASSUME RESPONSIBILITY FOR SELECTING THE 
SOFTWARE TO ACHIEVE YOUR INTENDED RESULTS, AND FOR THE INSTALLATION OF, USE OF, 
AND RESULTS OBTAINED FROM THE SOFTWARE. THE AUTHOR WILL NOT BE LIABLE FOR DATA 
LOSS, DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING 

THIS SOFTWARE AND(OR) ANY KIND OF DATA DERIVED. 
By using this software you agree to the above. 
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Notes on this document: 
This is on on-going project to cover the features in CTFileFilter, so please check back from time to 
time and download the most current guide. 
 
Notes on operational usage: 
CTFileFilter allows you to drag and drop files into the search boxes as well as navigate to files by 
double clicking on the search box.  For the purposes of this guide we will always assume that you 
are dragging and dropping files into the search fields. 
 
 
Some buttons work with keyboard shortcuts.  To see the shortcut key letters underlined on 
buttons, press the ALT button on your keyboard.  To activate the shortcut using the your keyboard, 
Press and hold the ALT button and then type the letter underlined on the CTFileFilter Button. 
 
 
While using CTFileFilter, anything that is copied to the clipboard will be copied onto the 'Scratch 
Pad' for easy access to the data when you require it. 
 
CTFileFilter will open documents in UltraEdit or Notepad in that order. 
 
 
Some examples below are written in a block of procedures, with other examples that refer to 
previous block of procedures.  These will be referenced with square brackets like this [1]Procedure 
name. 
 
A procedure that is displayed as follows: 
[1,2,3,4] means to follow procedures 1, 2, 3 and 4 before continuing 
If a procedure is optional, it will be shown within curly brackets {} 
[1,{2},3,4) means to follow procedures 1, 2 is optional, 3 and 4. 
 
 
Key: 
<BT: > = Click on the named button 
<DC: > = Double click the named box 
<DD: > = Drag and drop a file or directory to the named box 
<DB: > = Click on the named drop down box 
<KB: > = Press the named key on your keyboard 
<NB: > = Enter the quantity or use the up/down button in the name box  
 
<SD: > = Click on right hand downward pointing arrow of the named drop down list 
               and then click on a selection from that list 
<TAB: >= Click on the Tab          
<TB: >  = Tick the named tick box 
<TE: >  = Click on the text box 
<TY: >  = Type in the named box 
<UT: >  = Untick the named tick box 
{            = Optional selection 
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Terminology: 
Directory = Folder 
DD          = Day date as a number 
MM         = Month as a number 
YY          = Last two digits of the year 
YYYY     = Year 
HH         = Hour 
MN         = Minutes 
SS          = Seconds 
 
 
Date example: 
10:57am on 17th of October 2004 
 
Would be: 
DD   = 17 
MM   = 10 
YY   = 04 
YYYY = 2004 
HH   = 10 
MN   = 57 
SS   = 00 
 
 
Special characters 
%   = Used in file names to indicate the start and end of a Variable such as date 
To reference a file which has a changing name depending on the date such as 
'C:\FileDDMMYYYY.TXT' 
you could use a file name of 'C:\File%DD%%MM%%YYYY%.TXT', so every time you run the 
procedure today's date will be used. 
 
 
The options are: 
%DD%        = Day date as a number 
%MM%       = Month as a number 
%YY%        = Last two digits of the year 
%YYYY%   = Year 
%HH%       = Hour 
%MN%       = Minutes 
%SS%        = Seconds 
 
Note: these special characters are case sensitive. 
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Working out a date or time 
 
Note:This feature is intended for use with macros and automated tasks. 
 
Sometimes it may be necessary to see items of a specific date or time passed relative to today.  
For example it you have a log file that has the date DD/MM/YYYY on each line, you could search 
for just the lines from one month ago by entering the specific month and year.  However if you 
save this as a macro you will always get the same results when you run the macro.  A more 
dynamic way of entering the data is by using a date offset.  In this example a date offset would 
look like this %-1%%mm%%MM%/%YYYY%.  Here we are telling CTFileFilter that it should 
subtract one from the current month and then return the month and year details.  Now when the 
macro is run, it will always use the previous months month and year details.  
 
%dd%, %mm%, %yy%, %yyyy%, %hh%, %mn% and %ss% are used to calculate dates and times 
from today's date forward or backwards: 
 
To use a date of 7 days ago enter: 
%-7%%dd%%MM%/%YYYY% 
The lowercase %dd% following the date tells the system to take 7 from the days. 
 
To use a date of 5 months ago enter: 
%-5%%mm%%MM%/%YYYY% 
The lowercase %mm% following the number tells the system to take 5 from the months. 
 
To use a date of 3 years ago enter: 
%-3%%yyyy%%MM%/%YYYY% 
The lowercase %yyyy% following the number tells the system to take 3 from the years. 
 
Likewise you can add days months, years, hours, minutes and seconds on to today's date by 
entering a + symbol in place of a -. 
e.g. 
To use a date of 3 years' time: 
%+3%%yyyy%%MM%/%YYYY% 
The lowercase %yyyy% following the number tells the system to add 3 to the years. 
 
You may only use one adjustment to the date or time within one reference. 
So to use a date of 1 year and 2 days ago you could not use: 
%-1%%yyyy%%-1%%dd%%DD%%MM%%YYYY% 
 
But would be able to use: 
%-367%%dd%%DD%%MM%%YYYY% 
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****************************************************************************************** 
ALL SCREENS: 
****************************************************************************************** 
 

<BT:Scratch Pad> To show the Scratch Pad. 

<BT:Explore> Opens an explorer window listing all saved CTFileFilter 
macros. 

<BT:Edit> Allows editing of previously saved macros. 

<BT:Play> Enables the running of a previously saved macro. 

<BT:Record> Start the recording of a macro. 

 
 
****************************************************************************************** 
SCRATCH PAD 
****************************************************************************************** 
Purpose: Enables access to any items copied to the clipboard during the session 
 
 

<BT:Copy selected tab> Copies all the contents of the selected tab to the 
clipboard. 

<TB:Enable auto selection> When ticked will aid in the selection of individual 
words when clicking    on any of the scratch pad 
lists.  Untick this selection if you want to select 
more than one word. 

<BT:Go> Runs the selected macro on the contents of the 
'Scratch Pad' and puts the results on the Output 
tab. 

<SD:Please select a dropdown macro to 
run on the Scratch Pad> 

Various macros that will filter the scratchpad. 
 

<BT:X Clear selected> Deletes all the contents of the selected tab.      

<BT:V Paste clipboard> Pastes the clipboard contents to the bottom of the 
selected tab. 

 
Note: The contents of the Output tab and all the Note tabs are saved when CTFileFilter is closed, 
and loaded again when CTFileFilter is restarted.  The Scratch Pad tab is not saved so if you wish 
to keep its contents simply copy them to one of the Note tabs before closing CTFileFilter. 
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****************************************************************************************** 
Tab:     FILE 
****************************************************************************************** 
Purpose: Enables the quick searching of data and listing of files and directories. 
 
 
***** To search a file: 
<DD:File to Search>Your file to search 
<TY:Search for Phrase>Your wording to match 
<BT:Search> 
 
 
***** To search a directory/drive letter: 
<DD:File to Search>Your directory to search 
<TK:Search directory> 
<TY:Search for Phrase>Your wording to match 
<BT:Search> 
 
 
***** To search a file for a list of phrases: 
<DD:File to Search>Your file to search 
<TB:Search  
<UT:Search for Phrase> 
 
<DD:File to use for Searching>Your search phrase list 
 OR 
<BT:Use clipboard> to paste in your search phrase list  
  
<BT:Search> 
 
***** To search for a phrase with additional items required to match: 
<DD:File to Search>Your file to search 
<TY:Search for Phrase>Your wording to match 
<TY:and>Your list of additional search items separated by a # pipe. E.g. box#square#circle 
<BT:Search> 
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<BT:*> Clears the selected box 

<BT:*> & <KB:CTRL> Clears the selected item from the drop down list 

<BT:-> When multiple files are listed in the results, 
enables you to scroll up to the previous result. 

<BT:+> When multiple files are listed in the results, 
enables you to scroll down to the next result. 

  

<TB:1st match only> Will return only one match and ignore any other 
matches. 

{<TB:Trim search list> When a list of matches is used, all matched items 
are removed from the search list. 

  

<BT:and> Toggle between 'and', 'exclude', 'incList' and 
'excList'.  Note: the drop down box after the button 
is used to add in additional filtering to the matched 
item.  The incList and excList should be a pipe # 
separated list of items to include or exclude.  Use 
the additional { or } at the beginning and end of the 
list to set a boundary of where the data match 
should start and end within the line 

<TB:Append all search matches> When unticked the output will start on a clean 
sheet, otherwise it appends to the previous search 
results. 

<TB:Case sensitive> If ticked will match upper case and lower case 
letters. 

<BT:Clear results list> Clears the results. 

<BT:Clipboard> Copies the search results to the clipboard. 

<BT:Copy listed files to a folder> All the files listed are copied to a folder of your 
choice. 

<BT:Copy selected file to a folder> The highlighted file is copied to a folder of your 
choice. 

  

<TB:Display file name> Displays the full file location path and file name. 

{<TB:Display short file name> Displays only the actual file name without any 
location path details. 
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{<TB:Display file created date> Displays: Created: DD/MM/YYYY HH/MN/SS in 
the listed results. 

{{<BT:Sort by date> Organises the displayed results by created date 
from oldest to newest. 

{<TB:Display file updated date> Displays: Updated: DD/MM/YYYY HH/MN/SS in 
the listed results. 

{{<BT:Sort by date> Organises the displayed results by updated date 
from oldest to newest. 

  

<TB:Display found lines count> Displays: <FOUND>,total matches found, at the 
end of each output result list. 

  

<TB:Display found search item> If a match is found it displays: the search 
item,<Found>. 

{<TB:Only display<Found>> If a match is found, it only displays: <Found> in 
the listed results. 

  

<TB:Do not display found line> If a match is found, the item is not displayed. 

<BT:exclude> Toggle between 'and' and 'exclude'. Note: the drop 
down box after the button is used to add in 
additional filtering to the matched item. 

<BT:ISBN10> Converts all ISBN13 to ISBN10 in the search 
phrase or search file. 

<BT:ISBN13> Converts all ISBN10 to ISBN13 in the search 
phrase or search file. 

  

<TB:List items not found> If no match is found, displays: search item,<not 
found>. 

{<TB:Only display<Not found>> If no match is found, displays: <not found>. 

  

<NB:List lines after> Displays x number of lines after the matched line. 

{<TB:Indent> Indents the lines found after with <a>. 
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<NB:List lines before> Displays x number of lines before the matched 
line. 

{<TB:Indent> Indents the lines found before with <b>. 

  

<TY:List lines matching CSV> Enter a list of items to match separated by a 
comma. Only matches that also contain words 
found on this list will be displayed. 

{<TB:Leftmost> Words found on the list must be leftmost in the 
matched line. 

  

<TB:List only files/folder> Will search only the file names for matches. 

{<TB:CSV> Will output the result as a comma separated list.  
This can then be used for filtering. 

<TY:Record end> When wanting to see a complete record that 
contains a match, enter the label that signifies the 
record ending line. 

<TY:Record start> When wanting to see a complete record that 
contains a match, enter the label that signifies the 
record starting line. 

<BT:Remove non numeric> Removes all non-numeric characters from the 
search phrase or search file. 

<BT:Save to file> Saves the search results to a file name and 
location of your choice.  The default file suffix is 
.txt but you can enter any suffix you like. 

<TB:Search sub directories> Will search all sub directories within the selected 
directory. 

<BT:Search within this list> Allows you to search within the results list. 

<BT:Sort results A-Z> Sorts the results alphabetically A-Z. 

<TB:Use date> Only items that match and are in the file creation 
date range will be listed. 

<BT:View folder> Opens the highlighted file name folder 
Note: to view the selected file double clicking on 
the highlighted file name. 
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<BT:Goto line number> When clicked, will highlight the line number shown 
in the box to its right. 

<TB:Results on single line> All found results will be appended to a single line - 
the limit is 4096 characters. 

{<TB:1 Record per line> If using the Rec start and Rec end fields or 
searching a directory, the found matches can be 
displayed as 1 per line. 

<TB:Search backwards> Sometimes when searching large files where the 
matches are known to be close to the end of the 
file, this will speed things up. 

<TB:Use live file> By default FileFilter will copy a file that has been 
accessed in the last 9 hours and search the 
copied file.  Tick this box to switch this off.  Note 
by ticking this you could cause access problems 
for other applications that are trying to access the 
same file. 
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****************************************************************************************** 
Tab:     FILTER 
******************************************************************************************      
Purpose: Enables the viewing and filtering of data in CSV files and HTML type tables 
 
 
To speed the display up, the 'Lines to display' is initially set to 1000, but can be increased if 
required, or decreased to your desired lines of x. The button 'Copy 1000 lines to clipboard' will now 
change to 'Copy x lines to clipboard'.  The larger the number, the longer a screen refresh will take.  
Note: This option only affects the display and not any action on the filtering of the file data. 
 
 
Large files will take longer to process so please be patient when altering the data. 
 
 
 
***** [1]Display the file: 
<DD:File name> your file. 
 OR 
<BT:Paste from clipboard> to paste in your search data.  The first 'x' lines will now be displayed. 
 
 
 
 
***** [2]To split the file into columns: 
Depending on how your file is split, tick the relevant options in the 'Split' collection. 
<BT:Grid> the file will be split into columns.  Note: HTML tables are automatically displayed in 
columns. 
 
 
 
 
***** [3]Display a header from an alternative source: 
[1] 
<DD:Header source file> your file containing the column headers. 
<NB:Header source line> the line number that the headers are on. 
 
 
 
***** To convert a CSV type file to a single line file 
[1,2,{3}] 
<BT:Single line> the first x lines will be displayed in 'Single line' format. 
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***** To remove a column of data 
[1,2,{3}] 
In the 'Column display options' untick the columns that you do not want. 
<BT:Refresh columns> the first x lines will be displayed in columns. 
 
 
 
 
***** [4]To alter the column order 
[1,2,{3}] 
In the 'Column display options' click and hold on the 'ColumnX' label (where X is the number of the 
column) 
and drag it left or right and then release. 
<BT:Refresh columns> the first x lines will be displayed in columns. 
 
 
 
 
***** To add a column of data 
[1,2,{3}] 
<TB:Add a column> 
<BT:Refresh columns> the first x lines will be displayed in columns.  Note if the new column of 
data is left blank then you will not be able to add more columns and the new column will not be 
saved.  To add more columns follow [4] and then choose to add another column. 
 
 

<BT:De-quote file> removes quotations from around any text fields 

<BT:Single line> displays the 'File name' as a single line of text per 
column. 

<BT:Grid> displays the 'File name' in a column formatted grid. 

<BT:Filter column> runs the changes to the 'Column to work on' as 
per the tick box selection. 

<BT:Refresh columns> redisplays the columns after adding or removing 
columns. 

<BT:Save to file> saves the complete list to a file name and location 
of your choice.  The default file suffix is .CSV but 
you can enter any suffix you like. 

<BT:Search within this list> takes you to the 'File' tab to search within the 
results. 

<BT:Sort results A-Z> sorts the results alphabetically A-Z. 

<BT:View file> opens the 'File name' in a text editor. 
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****************************************************************************************** 
Tab:     FILE RENAMING 
****************************************************************************************** 
Purpose: For renaming files and splitting files into smaller parts 
 
 
***** To split a file 
<DD:File name> Your file to search 
<NB:How many lines per output file> Choose how many lines you would like per new file created 
<NB:Stop at file number> If you want the splitting to stop after a set amount of files are created 
then ajust this number to suit.  99999 is the default. 
<BT:Split file> A new sub directory in your file source directory will now be created and the split 
files will be created using a numeric file name. 
 
 
***** To split a file that contains records 
If you have a multi-line file that needs splitting that contains records e.g. multiline groups of data 
such as names and addresses or product information, you can create the split file with complete 
records. 
 
<DD:File name> Your file to search 
<NB:How many lines per output file> Choose how many lines you would like per new file created 
<NB:Stop at file number> If you want the splitting to stop after a set amount of files are created 
then adjust this number to suit.  99999 is the default. 
<TY:Record end label> This is the label that will appear on the last line of each record.  In the 
case of an address list it could be 'Country' 
<NB:Stop at record number> If you only want the process to get a select number of records before 
finishing change this number accordingly. 
<BT:Split file> A new sub directory in your file source directory will now be created and the split 
files will be created using a numeric file name.                                                                                                    
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***** To split a file that contains records and index it for faster searching 
This process is similar to the above one, but in addition the one element of the data is indexed so 
that future searches of that element information are a lot faster. 
 
<DD:File name> Your file to search 
<NB:How many lines per output file> Choose how many lines you would like per new file created 
<NB:Stop at file number> If you want the splitting to stop after a set amount of files are created 
then adjust this number to suit.  99999 is the default. 
<TY:Record end label> This is the label that will appear on the last line of each record.  In the 
case of an address list it could be 'Country' 
<NB:Stop at record number> If you only want the process to get a select number of records before 
finishing change this number accordingly. 
 
 
You will then need to select one of the following: 
<TB:Each record is unique and sequential> If the records have a unique field that is only listed 
once per source file such as a product code and are listed sequentially i.e. 0 to 99999999 then tick 
this box. 
 
OR 
 
<TB:Create an index file (for non-sequential files) Tick this for all other indexing 
<TY:Record start label(this is case sensitive) This is the label that represents the first line of the 
Record.  e.g. 'ProductCode' 
                                                
 
You will then need to select one of the following: 
<NB:Record character count> Set this to the length of the record label size, in the case of a bar 
code EAN the length of this is 13 characters. 
 
OR 
 
<TY:or record end characters> If the record index is of a variable size such as a surname then you 
can leave this blank or if there is also other data on the same line, enter the end characters.  E.g. 
Surname:Smith(Age:58) you could enter '(' as the end character. 
<BT:Split file> A new sub directory in your file source directory will now be created and the split 
files will be created using a numeric file name. 
                 
Once the file has been indexed and split, if you do a search in the 'File' Tab, by pointing to the split  
folder and search on the main criteria you indexed, the result will be displayed much quicker.              
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****************************************************************************************** 
Tab:     MOVE/EMAIL FILE 
****************************************************************************************** 
Purpose: Allows you to move files and email them according to a set of conditions 
 
Note: This facility is best used with the automated macro facility 
 
The moving and emailing of files gives a high degree of flexibility of how you deal with your files. 
 
Some scenarios: 
You have to regularly check file information to see if a file is above a certain size, you could run 
this process and set it up to send an email alert to yourself advising that there is a problem and 
advise the file size etc. 
 
You have a customer who only wants certain information from your data file. 
Simply create a macro that filters out the data your customer requires and then send an email with 
the data attached. 
 
You want to archive a file or folder that is older than a certain date. 
 
 

<TE:Source file or folder> The full path to the file or folder that you are 
referring to. 

<NB:Minimum file byte size> Optional file size that must be met for the process 
to continue. 

<NB:Days> Optional time in days that the file must be as old or 
older than. 

<NB:Hours> Optional time in hours that the file must be as old 
or older than. 

<NB:Minutes> Optional time in minutes that the file must be as 
old or older than. 

<NB:Required associated file> Optional full path to a file that must also exist for 
the process to continue. This is generally used for 
the older marker file that is made available to 
indicate when a file is available for download.  e.g. 
When the Stock.CSV file is ready for collection 
there is a StockReady.Txt file.  Only if the 
StockReady.Txt file exists will the process 
continue. 
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<TB:Copy the file to a new destination> If the criteria for the file or folder are met then copy 
the file. 

{<TE:Destination folder(file name optional)> Enter the folder location of where you would like to 
copy the source file to. 

{<TB:Delete the 'Destination' directory and 
contents before copying the new files over> 

Self-explanatory. 
 

{<BT:Unzip file> If the Source file is a zipped file i.e. file suffix .zip 
then this button will appear.  By clicking it you can 
unzip the file.  This will only allow unzipping of 
single files. 

  

<TB:Delete source file when finished> Only the source file/folder is removed and not the 
'Required associated file'. 

  

<TB:Send an email> If the criteria for the file or folder are met then send 
an email. 

{<TB:Email if the file is mising or below the 
minimum byte size> 

This allows for an email to be sent when the 
required criteria is not met. e.g. you may want to 
send an alert email if a file is missing, or not as 
large as you require. 

{<TB:Attach source file> You can send the Source file as an attachment to 
the email. 

{<TB:Use semicolon list> Instead of entering the email addresses directly, 
they can be read in from an external list.  The list 
must be plain text and each email address 
separated by a ';' semicolon e.g. 
fred.bloggs@gmail.com;JohnSmith12@Yahoo.co
m;info@cheekyted.co.uk e.t.c. 

{<TE:Output message> To add changeable information to the Subject: or 
Message: simply click in the relevant box and then 
click on the required item form the Output 
message box. 

<BT:Move File / Send eMail> Click to Move the file or send the email 
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****************************************************************************************** 
Tab:     FTP 
****************************************************************************************** 
Purpose: Allows you to upload and download files via FTP 
 
 

<TE:FTP Server> Server name e.g. upload.server.com 

<TE:User> FTP user login name 

<TE:Password> FTP user password 

<TE:Remote path and file> Directory and file name on the remote FTP server 

<NB:Minimum file byte size> Optional file size that must be met for the process 
to continue. 

<TE:Local path and file> Directory and file name on your PC of the target 
file. 

<NB:Required associated file> Optional full path to a file that must also exist for 
the process to continue. This is generally used for 
the older marker file that is made available to 
indicate when a file is available for download.  e.g. 
When the Stock.CSV file is ready for collection 
there is a StockReady.Txt file.  Only if the 
StockReady.Txt file exists will the process 
continue. 

<BT:Data direction = Download> A toggle button to confirm that the process will be 
downloading from the FTP server. 

<BT:Data direction = Upload> A toggle button to confirm that the process will be 
uploading to the FTP server. 

  

<TB:Use FTP Check List> Select to use if you are going to be 
uploading/downloading multiple files during one 
process. 

{<TE:Use FTP Check List> Directory and file name of the FTP 
upload/download check list of actions to follow. 
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{<BT:Add to 'FTP Check List' When using an FTP check list, you add to the list 
by entering all the required fields and then 
proceeding to upload/download the file.  If 
everything is successful then you can click this 
button to add the process to your FTP Check List. 
Next time you want to complete all the FTP 
processes, you only need to select the FTP Check 
List file and then click on Connect. 
 
To remove an item from your FTP check list, 
simply edit the file in notepad and delete the 
relevant line. 

  

<TB:Create log file if the 'Minimum file byte 
size' or 'Required associated file' is not met> 

Self-explanatory. 

<TE:Output results to log - folder path and file 
name> 

Full directory and file name of the FTP log file. 

<TB:Append to an existing log file> Leave unticked if you want to overwrite the log file 
each time, otherwise tick the box and the log file 
will be appended to. 

<TB:Add to log file> Tick if you require the FTP connection information 
added to the log file. 

<TE:Output message options> To add changeable information to the Message 
simply click on the required item form the Output 
message box. 

<BT:Connect> Connect to the FTP site and upload/download. 
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****************************************************************************************** 
Tab: VIEW 
****************************************************************************************** 
Purpose: To quickly allow the viewing of a 200k chunk of a file. 

Simply drag and drop your selected file to the File to display box (or double click on it and navigate 

to the file of your choice) 

If you want to open the full file, you will need to do this in the editor of your choice. 

 

 

****************************************************************************************** 
AUTOMATING MACROS (Professional version only) 
****************************************************************************************** 
 
Once you have saved a macro, you can schedule it to run automatically unattended through 
Windows Task Scheduler. 
 
For example, every day you need to download a CSV Price and Stock availability feed from a 
supplier, then filter out just the free stock items and items that are above a certain discount 
threshold, and then upload this list to your website. CTFilteFilter allows you to do all this by 
recording a macro of the process once.  All you then need do is create a Windows Scheduled task 
and call CTFileFilter.exe with the macro name after it. 
 
Example: 
Using Windows 7 
1) Create a Scheduled task 
2) Edit the task Actions 
3) Choose the action 'Start a program' 
4) In the Program/script enter the full path to your FileFilter.exe program e.g. "C:\FileFilter.exe" 
    Note: the quotation marks are required. 
5) In the 'Add arguments (optional)' box enter the full path to the macro e.g.  
 
"C:\FileFilter\Macros\MyMacroName.ffm" 
 
Note: the quotes are required as is the file suffix of .ffm 
 
6) Run the task to check it is set up ok, and all being well, that is it. 
 
 


